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INTRODUCTION 

There are hundreds of project management software products on the market today. “The Project Portfolio 
Management (PPM) market size is expected to grow from USD 2.52 Billion in 2015 to USD 4.63 Billion by 
2020, at a Compound Annual Growth Rate (CAGR) of 12.9%.”1 Leading vendors include Microsoft, CA 
Technologies, HP, Oracle (who acquired Primavera), Planview, and SAP. Many smaller companies also 
provide their own products. Unfortunately, many people who own this type of software have little idea how 
to use it. It is important to understand basic concepts of project management, such as creating a work 
breakdown structure, determining task dependencies, assigning resources, setting up project portfolios, and so 
on before making effective use of PPM software. Many project teams still use spreadsheets or other familiar 
software to help manage projects. However, if you can master a good project management software tool, it 
can really help in managing projects. This appendix summarizes basic information on project management 
software in general. It also provides a brief guide to using Microsoft Project Professional 2016, the latest 
version of this popular software.  

PROJECT MANAGEMENT SOFTWARE 

As described at the end of Chapter 1, there are three basic categories of project management software based 
on their capabilities: low-end, midrange, and high-end tools. The market size mentioned by Gartner is for 
Project Portfolio Management (PPM) software, or the high-end category. It is often used across large 
organizations to manage thousands of projects while also providing portfolio management features. Low-end 
tools today are often free or very inexpensive, and most are available online. For example, popular tools 
include Basecamp, Trello, Zoho Projects, and Wrike, to name a few. Several low-end tools focus on project 
team collaboration and coordination and may not have features like critical path analysis, resource allocation, 
and status reporting, like mid-range and high-end tools do. 

Microsoft Project Professional 2016 is considered to be a midrange tool. It is only one of Microsoft’s 
offerings in the project management realm as of 2016. Figure A-1 provides a summary of the “plans” or 
options for project management software available just from Microsoft. Notice that the options focus on who 
will be using the software and what type of features are needed. Often an organization needs a combination 
of tools. For example, project managers might focus on using Project Professional synced with Project 
Online, team members might use Project Lite, and PMO staff and executives might use Project Online. Now 
more than ever, deciding what project management software to use is a project in itself! 

Because this text focuses on work done by project managers and the software is available as a free 
trial, this Appendix provides a guide for using Project Professional 2016.   
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Figure A-1.  Microsoft Project Options, Source: Microsoft, April 2016 

(https://products.office.com/en-us/project/compare-microsoft-project-management-software) 

BASIC FEATURES OF PROJECT MANAGEMENT SOFTWARE 

What makes project management software different from other software tools? Why not just use a 
spreadsheet to help manage projects? 

 You can do a lot of project management planning and tracking using non-project management 
software. You could use a simple word processor to list tasks, resources, dates, and so on. If you put that 
information into a spreadsheet, you can easily sort it, graph it, and perform other functions. A relational 
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database tool (such as Microsoft Access) could provide even more manipulation of data. You can also use 
email, social media, and other tools to collaborate with others.  

 However, project management software is designed specifically for managing projects, so it normally 
includes several distinct and important features not found in other software products: 

• Creating work breakdown structures, Gantt charts, and network diagrams: As mentioned in this text, a 
fundamental concept of project management is breaking down the scope of the project into a work 
breakdown structure (WBS). The WBS is the basis for creating the project schedule, normally shown 
as a Gantt chant. The Gantt chart shows start and end dates of tasks as well as dependencies between 
tasks, which are more clearly shown in a network diagram. Project management software makes it 
easy to create a WBS, Gantt chart, and network diagram. These features help the project manager 
and team visualize the project at various levels of detail.  

• Integrating scope, time, and cost data: The WBS is a key tool for summarizing the scope of a project, and 
the Gantt chart summarizes the time or schedule for a project. Project management software allows 
you to assign cost and other resources to activities on the WBS, which are tied to the schedule. This 
allows you to create a cost baseline and use earned value management to track project performance 
in terms of scope, time, and cost in an integrated fashion. 

• Setting a baseline and tracking progress: Another important concept of project management is preparing a 
plan and measuring progress against the plan. Project management software lets you track progress 
for each activity. The tracking Gantt chart is a nice tool for easily seeing the planned and actual 
schedule, and other views and reports show progress in other areas. 

• Providing other advanced project management features: Project management software often provides other 
advanced features, such as setting up different types of scheduling dependencies, determining the 
critical path and slack for activities, working with multiple projects, and leveling resources. For 
example, you can easily set up an activity to start when its predecessor is halfway finished. After 
entering dependencies, the software should easily show you the critical path and slack for each 
activity. You can also set up multiple projects in a program and perform portfolio management 
analysis with some products. Many project management software products also allow you to easily 
adjust resources within their slack allowances to create a smoother resource distribution. These 
advanced features unique to project management are rarely found in other software tools. 

As you can see, there are several important features that are unique to project management software 
that make them worth using. Next you’ll learn what’s new in Project Professional 2016 and how to use basic 
features. 

WHAT’S NEW IN PROJECT PROFESSIONAL 2016 

If you are familiar with Project Professional 2013 or earlier versions, it may be helpful to review some of the 
new features in Project Professional 2016. An easy way to do this is by using one of the new features – a tab 
on the ribbon called “Tell me what you want to do.” Figure A-2 shows the results after typing in “What’s 
new” and then selecting “Get started.”  Figure A-3 summarizes the results after selecting “What’s new in 
Project 2016.”  
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Figure A-2. Finding what’s new with the Tell me what you want to do feature 

More flexible timelines 

With Project 2016, not only can you leverage multiple timelines to illustrate different phases or 

categories of work, but you can also set the start and end dates for each timeline separately, to paint 

a clearer overall picture of the work involved. 

Better control over resource scheduling 

Some resources have limited availability, and may have their time scheduled by a resource manager. 

With Project Professional 2016 and Project Online, project managers and resource managers can 

negotiate an agreement, called a resource engagement, to make sure that resources are being used 

appropriately and effectively throughout your organization. 

Do things quickly with Tell Me 

You'll notice a text box on the ribbon in Project 2016 that says Tell me what you want to do. This is a 

text field where you can enter words and phrases related to what you want to do next and quickly get 

to features you want to use or actions you want to perform. You can also choose to get help related 

to what you're looking for. 

New themes for Project 

There are now three Office themes that you can apply to Project 2016: Colorful, Dark Gray, and White.  

Figure A-3. What’s New in Project 2016 
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 Next, you will learn some basic information about Project Professional 2016 and explore the main 
screen elements and Help facility. 

USING PROJECT PROFESSIONAL 2016 

Before you can use any project management software effectively, you must understand the fundamental 
concepts of project management, such as creating a work breakdown structure (WBS), establishing 
dependencies between activities, entering duration estimates, assigning resources, and so on. This Appendix is 
included with several project management text books by the author. Make sure you review these concepts 
before using Project Professional 2016 so you understand what you are doing.  

Before You Begin 

This appendix assumes you are using Microsoft Project Professional 2016 with Windows 10 and are familiar 
with other Windows-based applications. Check your work by reviewing the many screen shots included in the 
steps, or by using the solution files that are available for download from the companion website for this text 
or from your instructor. Project Online Professional will also work with these instructions. 

NOTE: You need to be running Windows 7 or later to use Project Professional 2016 and an up-to-date browser. Certain 
features require internet connectivity. You can read more detailed system requirements and download a free trial 
from Microsoft. This powerful software is very expensive. Microsoft sells Project Professional 2016 on its 
website for $1,159.99 as of April 2016. Many colleges and universities provide the software to students either 
on campus or through remote access. If you can use remote access, the main requirement is high speed 
internet connectivity. Check with your instructor for details or for alternatives if you do not have easy access 
to the software. Project Online Professional is available as a free trial as of June 2018. 

This appendix uses several template files and a fictitious project to illustrate how to use the software. 
The WBS for the fictitious file uses the five project management process groups as level 2 items (initiating, 
planning, executing, monitoring and controlling, and closing). Standard deliverables under each of those 
process groups are included. Each section of the appendix includes hands-on activities for you to perform.  

NOTE: To complete some of the hands-on activities in the appendix, you will need to download files from 
www.intropm.com or www.pmtexts.com to your computer. When you begin each set of steps, make sure you 
are using the correct file. Save the files you create yourself in a different folder so you do not write over the 
ones you download. 

In addition, you will create the following files from scratch as you work through the steps: 

• 2016wbs.mpp 

• 2016schedule.mpp 

• 2016actuals.mpp 

You will also use the following file to create a hyperlink: 

• stakeholder register.doc 

Using the free Trial of Project Online (as of June 2018): 

If you plan to download the free trial, perform the following steps: 
1. Go to Microsoft’s website for free trials (https://products.office.com/en-us/project/compare-

microsoft-project-management-software?tab=1) as of June 2018) and click on the Try button under 

Project Online Professional. If  that link does not work, check for updates on www.intropm.com 

or www.pmtexts.com. Also, be sure to read the preinstall information, including the FAQs. 
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2. Enter your account information. You do need a Microsoft account. It used to be called a Windows 

Live account, so you may already have one if  you set it up for Xbox, SkyDrive, Office 2013, Office 

365 or other items. If  you do not have a Microsoft account, set one up for free. 

3. Install Project Professional 2016. Try the 32-bit option first. After downloading the exe file, run it 

and enter the product key Microsoft provides when prompted. If  you have problems, contact your 

instructor or Microsoft support. Follow instructions for the Project Online Professional trial. 

 Next you will learn how to start Microsoft Project Professional 2016 and open a Blank Project. 

Overview of Project Professional 2016 

The first step to mastering Project Professional 2016 is to become familiar with the major screen elements 
and the Help facility. This section describes each of these features. 

Getting Started and Finding Help 

To start Project Professional 2016: 

1. Open Project Professional 2016. There are slightly different methods for opening Project Professional 
2016 depending on your operating system. For example, in Windows 10, click the Start button on 
the taskbar, All Apps, and then click Project 2016 or type it in the search bar. Alternatively, a 
shortcut or icon might be available on the desktop; in this case, double-click the icon to start the 
software. 

2. Start a Blank Project. Click on Blank Project, the first option as shown in Figure A-4. The left part of 

the screen shows recent files (if you have any) and allows you to open other projects as well. The 

current date is the default project start date. 

 

Figure A-4. Project Professional 2016 initial options – access Blank Project 

3. Learn about basic tasks in Project. Click the Tell me what you want to do tab, type Help, click Get 

started, and then click Basic tasks in Project, as shown in Figure A-5.  

NOTE: The term “tasks” is used in Project Professional 2016, while PMI prefers to use the terms 

deliverables and activities. Also, the name of the software is often referred to as just Project or Project 2016. 
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Figure A-5. Help on basic tasks in Project 
4. Explore the basic tasks information. Click on Add tasks. Scroll down to read about the other options. 

You can also type in the search bar to explore other Help topics. When you are finished, close the 
Help window. 

Understanding the Main Screen Elements 

Review the main screen elements, as shown in Figure A-6. Look at some of the elements of the screen.  

• The Ribbon, tabs, and Quick Access toolbar are similar to other Office applications. 

• The timeline view is displayed below the ribbon. It shows a high-level view of the project 
schedule. You can easily copy the timeline into other software, as most of your stakeholders may 
want to see it and not the detailed schedule. 

• The default manual scheduling for new tasks is on the lower left of the screen. You can click that 
option to switch to automatic scheduling. 

• The default view is the Gantt chart view, which shows tasks and other information in a calendar 
display. (Recall from the note on the previous page that Microsoft uses the term tasks instead of 
deliverables or activities.) You can access other views by clicking the View icon on the far left 
side of the ribbon. 

• The areas where you enter information in a spreadsheet-like table are part of the Entry table. For 
example, you can see entry areas for Task Name, Duration, Start, Finish, and Predecessors. 

• You can make the Entry table more or less wide by using the Split bar. When you move the 
mouse over the split bar, your cursor changes to the resize pointer. Clicking and dragging the 
split bar to the right reveals columns for Resource Names and Add New columns. 

• The first column in the Entry table is the Indicators column. The Indicators column displays 
indicators or symbols related to items associated with each task, such as task notes or hyperlinks 
to other files.  

• The file name displays centered at the top of the screen. When you open a Blank Project after 
starting Project 2016, it opens a new file named Project1, which is shown in the title bar. If you 
open a second Blank Project, the name will be Project2, and so on, until you save and rename 
the file. 
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  Indicators column    Tabs     Entry table    Gantt chart view (default view) 

 

Figure A-6. Project Professional 2016 main screen 

Many features in Project Professional 2016 are similar to ones in other Windows programs. For 
example, to collapse or expand tasks, click the appropriate symbols to the left of the task name. To access 
shortcut items, right-click in either the Entry table area or the Gantt chart. Many of the Entry table operations 
are very similar to operations in Excel. For example, to adjust a column width, click and drag between the 
column heading titles. 

Next, you will get some hands-on experience by opening an existing file to explore various screen 
elements. Project Professional 2016 comes with several template files, and you can also access templates from 
various websites.  

EXPLORING PROJECT PROFESSIONAL 2016 USING A 
TEMPLATE FILE 

To open a template file and adjust screen elements: 

1. Open a template file. Click the File tab, select New, click Market Research Schedule, and then 
click Create. These screen shots were taken on April 7, 2016, so you can enter that date if  you 
like or leave the default as “Today” or the current date. Your screen should resemble Figure 
A-7. (Note: If  you cannot find the template, you can download it from www.intropm.com 
and open it. To open an existing file, click the File tab, then select Open, and browse to find 
the file.) 

2. Move the Split Bar. Move the Split Bar to the right so the Task Name and Duration columns are 
visible. 

3. Expand a WBS item. Click on the arrow to the left of Initiation Phase in the Task Name column to 
reveal the activities under that WBS item. 

4. View the second Note: Move your mouse over the yellow Notes symbol in the Indicators column for 
Task 7 to read it. You can insert notes for any task by using the Notes icon on the ribbon.                                        

Quick 
Access 
Toolbar 
 
Ribbon 
Timeline 
 
 
 
Split bar 
 
 
 
 
 
Manual/ 
automatic 
scheduling 
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Figure A-7. Market research schedule template file 

To show different WBS levels and adjust the timescale: 

1. Select Outline Level 1 to display WBS level 2 tasks. Click the View tab and then the Outline button’s list 
arrow, and then click Outline Level 1. Notice that only the level 2 WBS items display in the Entry table.  
The black bars on the Gantt chart represent the summary tasks. Recall that the entire project is normally 
referred to as WBS level 1, and the next highest level is called level 2.  

2. Adjust the timescale. Click the Zoom out button (minus sign) on the left side of  the Zoom slider on 
the lower left of  the screen, as shown in Figure A-8, until you see all of  the symbols on the Gantt chart 
(click it three times). Notice the timescale is now showing quarters instead of  weeks. It is often easier to 
read the schedule when all of  the symbols are visible. You can also Zoom in when more details are 
needed. 

                                      Outline button                Timeline check box    Zoom out timescale  

                  on slider bar 

 

Figure A-8. Showing level 1 of the WBS and adjusted timescale 

3. View all tasks. Click the Outline button and select All Subtasks to see all of the items in the Task 
Name column again. Remember that you can expand or collapse tasks as desired. 

 
 
Split bar 

 
 
 

 
Notes 
indicator 
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To adjust, add multiple timelines, share, and print the timeline: 

1. Remove the timeline and display it again. Click the Timeline checkbox on the Ribbon to unselect it. Click it 
again to display it. The timeline is different than the time scale as it shows a high-level schedule on one 
line while the timescale adjusts the time units for symbols on the Gantt chart. 

2. Add a new timeline:  Click anywhere on the current timeline (toward the left side of the screen), click 
the Format tab, and then click Timeline Bar button under the Timeline Tools. Drag the line between the 
Timeline and Gantt Chart to reveal the second timeline. Your screen should resemble Figure A-9. 

Drag to see second timeline   Timeline bar button 

 

Figure A-9. Adding a second timeline. 

3. Add tasks to the new timeline. Right-click on Task 2, Requirements Gathering & Analysis, then click Add 
to Timeline. Scroll down to also right-click on Task 7, Project Charter Development, and then click Add 
to Timeline to add it as well.   

4.  Adjust the dates and format of the new timeline. Right-click anywhere in the second timeline, click Date 
Range, and then click Set custom dates. Enter 4/1/04 for the Start date and 5/1/04 for the finish dates. 
(Remember that this is a template file from Microsoft, and it had the dates entered as 2004).  

5. Display a task as a callout on the timeline. Right-click on Project Charter Development in the second 
timeline, and then click Display as callout. Click and drag on the callout to move it down and to the right, 
as shown in Figure A-10. You can also right-click on a task to change its color or font, if desired. 
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Figure A-10. Second timeline with callout. 

6. Close the file without saving. Click the Close icon in the upper right of the window, and select No when 
prompted to save the file. 

Project Professional 2016 Views 

Project Professional 2016 provides many ways to display or view project information. In addition to the 
default Gantt chart, you can view the network diagram, calendar, and task usage views, to name a few. These 
views allow you to analyze project information in different ways.  The View tab also provides access to 
different tables that display information in various ways. In addition to the default Entry table view, you can 
access tables that focus on data related to areas such as the Schedule, Cost, Tracking, Variance, and Earned 
Value tables. 

To access and explore different views: 

 1. Explore the Network Diagram for the Market Research Schedule file. Open the Market Research Schedule 
file again.  Click the View tab, the Outline button, and All Subtasks again. Click the Network Diagram 
button, and then move the Zoom slider on the lower right of  the screen all the way to the left. Your 
screen should resemble Figure A-11. Critical tasks automatically display in red in the Network Diagram 
view. 

2. Explore the Calendar view. Click the Calendar button (under the Network Diagram button). Notice 
that the screen lists tasks each day in a calendar format. 

3. Change the table view. Click the Gantt Chart button on the ribbon, click the Tables button, and then 
click Schedule. Figure A-12 shows the tables view options.  
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Network Diagram   

 

Figure A-11. Network diagram view 

 

Figure A-12. Tables view options 

4. Examine the Schedule table and other views. Move the Split bar to the right to review the Total Slack 
column. Notice that the columns in the table to the left of  the Gantt chart, as shown in Figure A-13, 
now display more detailed schedule information, such as Late Start, Late Finish, Free Slack, and Total 
Slack. Remember that you can widen columns by double-clicking the resize pointer to the right of  that 
column. You must do this for the Start, Finish, and Late Start columns to remove the #### symbols. 
You can also move the split bar to reveal more or fewer columns. Experiment with other table views, 
then return to the Entry table view. 
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Figure A-13. Schedule table view 

5.  Close the file without saving. Click the Close icon in the upper right of the window, and select No when 
prompted to save the file. You can also close Project Professional 2016 if you want to take a break. 

Project Professional 2016 Reports 

Project Professional 2016 provides many ways to report project information as well. In addition to traditional 
reports, you can also prepare visual reports, with both available under the Report tab. Note that the visual 
reports often require that you have other Microsoft application software, such as Excel and Visio. Project 
Professional 2016 automatically formats reports for ease of printing.  

To access and explore different reports: 

1. Open another template file. With Project 2016 open, click on the File tab, click New, then double-click 
on the template called Earned value. Read the information on the initial screen to learn more about the 
concept of  earned value. Click on the View tab, then click the Gantt chart icon. 

2. Explore the reports feature. Click the Report tab to see the variety of  reports available in Project 
2016, as shown in Figure A-14. 

 

Figure A-14. Report options 

 3. View the Project Overview report. Click Dashboards, and then double-click Project Overview. Review 
the report, noting that the project is 17% complete. You must have entered some actual information and cost 
data to take advantage of  this report. Also notice the new options on the ribbon, as shown in Figure A-15.  
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Figure A-15. Project Overview report 

 4. Open the Resource Overview report. Click the Report tab again, click Resources, and then click 
Resource Overview. Review the report, as shown in Figure A-16. 

 

Figure A-16. Resource Overview report 

 5. Examine other reports. Click on the Report tab, click In Progress, and then click Critical Tasks to 
display the Critical Tasks report, as shown in Figure A-17. Examine other reports. 
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Figure A-17. Critical tasks report 

 6. Return to the Gantt chart. Click the View tab, and then click on Gantt Chart to return to the Gantt 
chart view. Next, you will use this same file to explore filters. 

Project Professional 2016 Filters 

Project Professional 2016 uses a relational database to filter, sort, store, and display information. Filtering 
project information is very useful. For example, if a project includes thousands of tasks, you might want to 
view only summary or milestone tasks to get a high-level view of the project by using the Milestones or 
Summary Tasks filter from the Filter list. You can select a filter that shows only tasks on the critical path if 
that is what you want to see. Other filters include Completed Tasks, Late Tasks, and Date Range, which 
displays tasks based on dates you provide. As shown earlier, you can also click the Outline button on the 
toolbar to display different levels in the WBS quickly.  

To explore Project Professional 2016 filters: 

1. Access filters. Click the Filter list arrow, as shown in Figure A-18. The default filter is No Filter, which 
shows all tasks.  

      Filter list arrow 

 

Figure A-18. Using a filter 
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2. Filter to show milestones. Click Milestones in the list of  filters. Notice that the Gantt chart only shows 
the summary tasks and milestones for the project. Your screen should resemble Figure A-19. Recall that 
milestones are significant events. 

3. View other filters. Click the Filter list arrow, and then click Critical. Now only the critical tasks appear 
in the WBS (which happens to be all of  the tasks in this file). Experiment with other filters. 

 

Figure A-19. Milestones filter applied  

4. Close the file without saving. When you are finished reviewing the Earned value file, click the Close 
icon for the window, and select No when prompted to save the file.  

5. Exit Project 2016. Review other template files, if  desired. When you are finished, click the Close 
icon for Project 2016. 

Now that you are familiar with the main screen elements, views, reports, and filters, you will learn 
how to use Project Professional 2016 to create a new file. 

CREATING A NEW FILE AND ENTERING TASKS IN A WORK 
BREAKDOWN STRUCTURE 

To create a new Project Professional 2016 file, you must first enter the start date, and then enter the tasks. 
The list of tasks, if entered properly, show the deliverables for the project in a work breakdown structure 
(WBS) format. Deliverables can be broken down into activities to show more specific actions required to 
complete the work. The file you create in the following steps could be used for a class project which lasts 
approximately three months. It uses the project management process groups to reinforce use of several 
project management deliverables described in this text.  

NOTE: In this section, you will go through several steps to create a new Project Professional 2016 file 
named 2016wbs.mpp. If you want to download the completed file to check your work or continue to the next 
section, a copy is available on the companion website for this text at www.intropm.com. Try to complete an 
entire section of this appendix (entering tasks in a work breakdown structure, developing the schedule, and so 
on) in one sitting to create the complete file.  

Creating a New Project File 

To create a new project file: 

1. Create a blank project. Open Project 2016 and click on Blank Project. A blank project file opens with a 
default filename of  Project1, Project2, and so on. (If  Project 2016 is already open and you want to open 
a new file, click the File tab, select New, and then Blank Project.) 

 2. Open the Project Information dialog box. Click the Project tab, and then click Project Information to 
display the Project Information dialog box, as shown in Figure A-20. This dialog box enables you to set 
dates for the project, select the calendar to use, and view project statistics. The project start date will 
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default to the current date. Note that in Figure A-20 the file was created on 4/11/16 and a Start date of  
5/2/16 was entered. 

NOTE: All dates are entered in month/day/year or American format. You can change the date format by 

selecting Options from the File tab. Click the date format you want to use in the Date Format box under the 
General settings. You can also customize the Ribbon, change default currencies in the display, and so on 
under Project Options. 

 

 3. Enter the project start date. In the Start date text box, enter 8/1/16. Setting your project start date to 
8/1/16 will ensure that your work matches the results that appear in this appendix. Change the Current 
date to 8/1/16 as well. Click OK or press Enter. 

  Start date text box     Current date text box 

 

Figure A-20. Project information dialog box 

Creating a Work Breakdown Structure Hierarchy 

A work breakdown structure (WBS) is a fundamental part of project management. Developing a good WBS 
takes time, and it will make entering tasks into the Entry table easier if you develop the WBS first. For this 
example, you will use the project management process groups as the main WBS categories and add some key 
deliverables, activities, and milestones under each one. You will use the information in Figure A-21 to enter 
tasks. For the first task, enter your name, not the text “enter your name.” Note that Microsoft Project uses 
the term tasks instead of deliverables or activities or milestones, so it is also used in this appendix. 
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1. Initiating – enter your name 16. Activity D1 

2. Stakeholder identification 17. Activity D2 

3. Stakeholder register completed 18. Deliverable 1 completed 

4. Stakeholder management strategy 
completed 

19. Deliverable 2 

5. Project charter 20. Deliverable 3 

6. Project charter completed 21. Monitoring and Controlling 

7. Kickoff  meeting 22. Actual hours tracking 

8. Kickoff  meeting completed 23. Project documents updates 

9. Planning 24. Progress report 1 

10. Schedule 25. Progress report 2 

11. Gantt chart completed 26. Team review meetings 

12. Scope statement 27. Closing 

13. Initial scope statement completed 28. Final project report 

14. Executing 29. Final project presentation 

15. Deliverable 1 30. Project completed 

Figure A-21. Task list for 2016wbs file 

To develop a WBS for the project: 

 1. Enter task names. Enter the 30 items in Figure A-21 into the Task Name column in the order 
shown. To not have the text wrap, click on the Format Tab, click Column Settings, and then click 
Wrap Text to turn it off. Do not worry about durations or any other information at this time. Type 
the name of  each item into the Task Name column of  the Entry table, beginning with the first row. 
Press Enter or the down arrow key on your keyboard to move to the next row.  

HELP: If you accidentally skip a row, highlight the task row, right-click, and select Insert Task. To edit a task 
entry, click the text for that task, and either type over the old text or edit the existing text. Entering tasks into 
Project Professional 2016 and editing the information is similar to entering and editing data in an Excel 
spreadsheet. You can also easily copy and paste text from Excel or Word into Project, such as the list of 
tasks. 

2. Adjust the Task Name column width as needed. To make all the text display in the Task Name column, 
move the mouse over the right-column gridline in the Task Name column heading until you see the 
resize pointer , and then click the left mouse button and drag the line to the right to make the column 
wider, or simply double-click to adjust the column width automatically. 

This WBS separates tasks according to the project management process groups of initiating, 
planning, executing, monitoring and controlling, and closing. These categories will be the level 2 items in the 
WBS for this project. (Remember the whole project is level 1.) It is a good idea to include all of these process 
groups because there are important deliverables that must be done under each of them. Recall that the WBS 
should include all of the work required for the project. In this example, the WBS will be purposefully left at a 
high level (level 3). You will create these levels, or the WBS hierarchy, next when you create summary tasks. 
For a real project, you would usually break the WBS into even more levels and then enter activities to provide 
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more details to describe all the work involved in the project. For example, each deliverable would probably 
have several levels, activities, and milestones under it. You can review other texts, template files, or other 
WBSs for more information. This appendix focuses on the mechanics of using Project Professional 2016. 

Creating Summary Tasks 

After entering the items listed in Figure A-21 into the Entry table, the next step is to show the WBS levels by 
creating summary tasks. The summary tasks in this example are Tasks 1 (initiating), 9 (planning), 14 
(executing), 21 (monitoring and controlling), and 27 (closing). Task 15 (Deliverable 1) under executing is also 
a summary task with Activity D1 and Activity D2 under it. You create summary tasks by highlighting and 
indenting their respective subtasks. 

To create the summary tasks: 

1. Select lower level or subtasks. Click on the Task tab. Highlight Tasks 2 through 8 by clicking the cell for 
Task 2 and dragging the mouse through the cells to Task 8. 

2. Indent subtasks. Click the Indent Tasks button on the ribbon (or press Alt + Shift + right arrow) so 
your screen resembles Figure A-22. After the subtasks (Tasks 2 through 8) are indented, notice that Task 
1 automatically becomes boldface, which indicates that it is a summary task. A collapse symbol appears to 
the left of  the new summary task name. Clicking the collapse symbol (filled triangle sign) will collapse the 
summary task and hide the subtasks beneath it. When subtasks are hidden, an expand symbol (unfilled 
triangle sign) appears to the left of  the summary task name. Clicking the expand symbol will expand the 
summary task. Also, notice that the symbol for the summary task on the Gantt chart has changed from a 
blue to a black line with arrows indicating the start and end dates. The Task Mode has also changed to 
make this task automatically scheduled. You’ll learn more about this feature later. For now, focus on 
entering and indenting the tasks to create the WBS. 

 
Expand or collapse symbols by 
Summary tasks        Indent Task    Summary task symbol 

 

Figure A-22. Indenting tasks to create the WBS hierarchy 

3. Create other summary tasks and subtasks. Create subtasks and summary tasks for the other process 
groups by following the same steps. Indent Tasks 10 through 13 to make Task 9 a summary task. Indent 
Tasks 15 through 20 to make Task 14 a summary task. Indent Tasks 22 through 26 to make Task 21 a 
summary task. Indent Tasks 28 through 30 to make Task 27 a summary task. Widen the Task Name 
column to see all of  your text, as needed. 

4.  Create another level in the WBS. Indent Tasks 16 and 17 to make Task 15 a summary task. Notice that 
Task 15 is indented even further. On a real project, you would also break down the activities for other 
deliverables. 
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TIP: To change a task from a subtask to a summary task or to change its level in the WBS, you can 
“outdent” the task. To outdent the task, click the cell of the task or tasks you want to change, and then 
click the Outdent Task button (the button just to the left of the Indent Task button). You can also press 
Alt + Shift + Right Arrow to indent tasks and Alt + Shift + Left Arrow to outdent tasks. 

Numbering Tasks 

To display automatic numbering of tasks using the standard tabular numbering system for a WBS: 

1. Show outline numbers. Click the Format tab, and then click the Outline Number checkbox on the 
right side of  the ribbon. Project Professional 2016 adds the appropriate WBS numbering to the task 
names. Note that you can customize the numbering format as desired. 

2. Show project summary task. Click the Project Summary checkbox just below the Outline Number 
checkbox. Scroll to the top of  the file to see that a new task, Project 1, the name of  the file, has been 
added under row 0. Your file should resemble Figure A-23. 

 
Outline Numbers                           Outline Number and Project Summary Task check boxes 
 

 

Figure A-23. Adding automatic outline numbers and a project summary task 

Saving Project Files without a Baseline 

An important part of project management is tracking performance against a baseline, or approved plan. It is 
important to wait until you are ready to save your file with a baseline because Project Professional 2016 will 
show changes against a baseline. Since you are still developing your project file for this project, you want to 
save the file without a baseline, which is the default way to save a file. Later in this appendix, you will save the 
file with a baseline. You will then enter actual information to compare planned and actual performance data. 

To save a file without a baseline: 

1. Save your file. Click the File tab and then click Save, or click the Save button on the Quick Access 
toolbar. 

2. Enter a filename. In the Save dialog box, type 2016wbs in the File name text box. Browse to the 
location in which you want to save the file, and then click Save.  
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3. Close Project Professional 2016. Click the Close icon to exit. 

HELP: If you want to download the file 2016wbs.mpp to check your work or continue to the next section, a 
copy is available on the companion Website for this text, the author’s Website, or from your instructor. 

DEVELOPING THE SCHEDULE 

Many people use Project Professional 2016 for its scheduling features. The first step in using these features, 
after inputting the tasks for the project, is to change calendars, if needed, and then enter durations for tasks or 
specific dates when tasks will occur. You must also enter task dependencies in order for schedules to adjust 
automatically and to do critical path analysis. After entering durations and task dependencies, you can view 
the network diagram, critical path, and slack information.  

Calendars 
The standard Project Professional 2016 calendar assumes that working hours are Monday through Friday, 
from 8:00 a.m. to 5:00 p.m., with an hour for lunch from noon until 1:00 p.m.  In addition to the standard 
calendar, Project also includes a 24 Hours calendar and Night Shift calendar. The 24 Hours calendar assumes 
resources can work any hour and any day of the week. The Night Shift calendar assumes working hours are 
Monday through Saturday, from 12:00 a.m. to 3:00 a.m., 4:00 a.m. 8 a.m., and 11 p.m. to 12 a.m. You can 
create a different base calendar to meet your unique project requirements.  
 
To create a new base calendar: 

1. Open a new file and access the Change Working Time dialog box. With Project Professional 2016 open, click 
the Project tab, and then click the Change Working Time button under the Properties group. The 
Change Working Time dialog box opens, as shown in Figure A-24. 

2. Name the new base calendar. In the Change Working Time dialog box, click Create New Calendar. The 
Create New Base Calendar dialog box opens. Click the Create new base calendar radio button, type 
Fiscal as the name of the new calendar in the Name text box, and then click OK.  

3. Change the fiscal year start. In the Change Working Time dialog box, click Options at the bottom of the 
screen. Change the fiscal year to start in October instead of January. Review other options in this 
screen, and then click OK twice. 
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Figure A-24. Change Working Time dialog box 

You can use this new calendar for the whole project, or you can assign it to specific resources on the project. 

To assign the new calendar to the whole project: 

1. Open the Project Information dialog box. Click the Project tab, and then click the Change Working Time 
button.  

2. Select a new calendar. Click the For calendar list arrow to display a list of available calendars. Select 
your new calendar named Fiscal from this list, and then click OK. 

To assign a specific calendar to a specific resource: 

1. Assign a new calendar. Click the View tab, and then click the Resource Sheet button under the 
Resource Views group. Type Adam in the Resource Name column, and then press Enter. 

2. Select the calendar. Click the cell under the Base column that says Standard on the right part of the 
screen for Adam. Click the list arrow to display the options, and then select Fiscal as shown in Figure A-
25. 

 

Figure A-25. Changing calendars for specific resources 
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3. Block off vacation time. Double-click the resource name Adam to display the Resource Information 

dialog box, and then click the Change Working Time button, located on the General tab in the 
Resource Information dialog box. You can block off vacation time for people by selecting the 
appropriate days on the calendar and marking them as nonworking days. Click OK to accept your 
changes, and then click OK to close the Resource Information dialog box. 

4. Close the file without saving it. Click the Close box, and then click No when you are prompted to save 
the file. 

Entering Task Durations 

Recall that duration includes the actual amount of time spent working on an activity plus elapsed time. 
Duration does not equal effort.  For example, you might have an activity that you estimate will take one 
person 40 hours of effort to complete, but you allow two weeks on a calendar for its duration. You can 
simply enter 2w (for two weeks) in the Duration column for that activity (called a task in Project Professional 
2016). 

Manual and Automatic Scheduling 

If you have used older versions of Project, you may have noticed that when you entered an item in the Task 
Name column, it was automatically assigned a duration of one day, and Start and Finish dates were also 
automatically entered. This is still the case in Project 2016 (and Project 2013) if you use automatic scheduling 
for a task. If you use manual scheduling, no durations or dates are automatically entered. The other big 
change with manual scheduling is that summary task durations are not automatically calculated based on their 
subtasks when they are set up as manually scheduled tasks. Figure A-26 illustrates these differences. Notice 
that the Manual subtask 1 had no information entered for its duration, start, or finish dates. Also note that the 
duration for Manual summary task 1’s duration is not dependent on the durations of its subtasks. For the 
automatic summary task, its duration is dependent on its summary tasks, and information is entered for all of 
the durations, start, and end dates. You can switch between automatic and manual scheduling for tasks in the 
same file, as desired, by changing the Task Mode. 

 

Figure A-26. Manual versus automatic scheduling 

When you move your mouse over the Task Mode column (shown in the far left in Figure A-26) 
Project Professional 2016 displays the following information:  

• A task can be either Manually Scheduled or Automatically Scheduled. 

• Manually Scheduled tasks have user-defined Start, Finish and Duration values. Project will 
never change their dates, but may warn you if there are potential issues with the entered 
values. 

• Automatically Scheduled tasks have Start, Finish and Duration values calculated by Project based on 
dependencies, constraints, calendars, and other factors. 

 
 Project Help provides the following example of using both manual and automatic scheduling. You 
set up a preliminary project plan that’s still in the proposal stage. You have a vague idea of major milestone 
dates but not much detail on other dates in various phases of the project. You build tasks and milestones 
using the Manually Scheduled task mode. The proposal is accepted and the tasks and deliverable dates 
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become more defined. You continue to manually schedule those tasks and dates for a while, but as certain 
phases become well-defined, you decide to switch the tasks in those phases to the Automatically Scheduled 
task mode. By letting the software handle the complexities of scheduling, you can focus your attention on 
those phases that are still under development.   

Duration Units and Guidelines for Entering Durations 

To indicate the length of a task’s duration, you normally type both a number and an appropriate duration 
symbol. If you type only a number, Project Professional 2016 automatically enters days as the duration unit. 
Duration unit symbols include: 

• d = days (default) 

• w = weeks 

• m = minutes 

• h = hours 

• mo or mon = months 

• ed = elapsed days 

• ew = elapsed weeks 

For example, to enter two weeks for a task’s duration, type 2w in the Duration column. (You can 
also type wk, wks, week, or weeks, instead of just w.) To enter four days for a task’s duration, type 4 or 4d in 
the Duration column. You can also enter elapsed times in the Duration column. For example, 3ed means 
three elapsed days, and 2ew means two elapsed weeks. 

You would use an elapsed duration for a task like “Allow cement to dry.” The cement will dry in 
exactly the same amount of time regardless of whether it is a workday, a weekend, or a holiday. Project’s 
default calendar does not assume that work is done on weekends. You will learn to change the calendar later 
in this appendix. 

It is important to follow a few important rules when entering durations: 

• To mark a task as a milestone, enter 0 for the duration. You can also mark tasks that have a non-
zero duration as milestones by checking the “Mark task as milestone” option in the Task 
Information dialog box on the Advanced tab. You simply double-click a task to access this dialog 
box. The milestone symbol for those tasks will appear at their start date. 

• You can enter the exact start and finish dates for activities instead of  entering durations in the 
automatic scheduling mode. To enter start and finish dates, move the split bar to the right to 
reveal the Start and Finish columns. You normally only enter start and finish dates in this mode 
when those dates are certain. 

• If  you want task dates to adjust according to any other task dates, do not enter exact start and 
finish dates. Instead, enter durations and then establish dependencies to related tasks.  

• To enter recurring tasks, such as weekly meetings, select Recurring Task from the Task button 
under the Task tab, Insert group. Enter the task name, the duration, and when the task occurs. 
Project Professional 2016 will automatically insert appropriate subtasks based on the length of  
the project and the number of  tasks required for the recurring task.  

• Remember to change the default calendar if  needed, as shown earlier.  

Next, you will set task durations in the file that you created and saved in the previous section. If you 
did not create the file named 2016wbs.mpp, you can download it from the companion Website for this text.  
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Use the information in Figure A-27 to enter durations. The Project Professional 2016 row number is 
shown to the left of each task name in the table. 

Task Row Task Name Duration 

2 Stakeholder identification 1w 

3 Stakeholder register completed 0 

4 Stakeholder management strategy completed 0 

5 Project charter 1w 

6 Project charter completed 0 

7 Kickoff meeting 3d 

8 Kickoff meeting completed 0 

10 Schedule 5d 

11 Gantt chart completed 0 

12 Scope statement 8d 

13 Initial scope statement completed 0 

16 Activity D1 4w 

17 Activity D2 6w 

18 Deliverable 1 completed 0 

19 Deliverable 2  3w 

20 Deliverable 3  5w 

24 Progress report 1 0 

25 Progress report 2 0 

28 Final project report 4d 

29 Final presentation 4d 

30 Project completed 0 

Figure A-27. Task durations 
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Entering Task Durations 

To enter task durations: 

1. Enter the duration for Task 2. Open the 2016wbs file, and move the split bar to the right, if  needed, to 
reveal the Duration, Start, and Finish columns. Click the Duration column for row 2, Stakeholder 
identification, type 1w, and then press Enter. Notice that the duration for the first task, Initiating, also 
changed since it is a summary task and is an Automatically scheduled task, as shown in the Task Mode 
column. When you created summary tasks earlier, the software changed their scheduling mode to 
Automatic. Also notice that the Start and Finish date for Task 2 remain blank, since that task is a 
Manually scheduled task. 

2. Enter the duration for Task 3.  In the Duration column for row 3, Stakeholder register completed, type 
0, and then press Enter. Remember that a task with zero duration is a milestone. Notice the milestone or 
diamond symbol next to the date 8/1 that appears on the Gantt chart, as shown in Figure A-28. 
Remember that you can adjust the Task Name column width to see all of  the text and use the Zoom 
slider to change the length of  the Gantt chart bars.  

Task Mode column 

Figure A-28. 
Entering task durations 

3. Make all tasks automatically scheduled tasks. To save time because you do want most of  the tasks to be 
automatically scheduled, select all of  the tasks by clicking the Task Name column heading, and then 
click the Auto Schedule button under the Task tab, as shown in Figure A-29. Most of  the durations 
change to 1. 

4. Enter remaining task durations. Continue to enter the durations using the information in Figure A-27 or 
Figure A-30. Do not enter durations for tasks not listed in the figure. Notice that the Planning Wizard 
dialog box displays when you make the same entry several times in a row, such as after task 20. Click OK 
to close the dialog box. You can adjust the column widths and Zoom, if  desired. 
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Figure A-29. Auto scheduling tasks 

 
Figure A-30. Entering more durations  

5. Insert a recurring task above Task 26, Team meetings. Click Team review meetings (Task 26) in the Task 

Name column to select that task. Click the Task tab, and click the Task button drop-down box, and 
then click Recurring Task. The Recurring Task Information dialog box opens. 

6. Enter task and duration information for the recurring task. Type Team review meetings as the task title in 
the Task Name text box. Type 15min in the Duration text box. Select the Weekly radio button under 
Recurrence pattern. Make sure that 1 is entered in the Recur every list box. Select the Thursday check 
box. In the Range of  recurrence section, click the End after radio button, and then type 12 in the 
occurrences text box, as shown in Figure A-31. The new recurring tasks will appear indented below Task 
26 when you are finished.  

7.  Delete row 39 to avoid redundancy. Right-click on row 39, then click Delete Task. 
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Figure A-31. Recurring task information dialog box 

TIP: You can also enter End by date for a recurring task instead of a number of occurrences. You might 
need to adjust the entry after you enter all of your task durations and dependencies.  

8. View the new summary task and its subtasks. Click OK. Project Professional 2016 inserts 12 team review 
meetings subtask in the Task Name column. Notice that the recurring tasks appears on the appropriate 
dates on the Gantt chart. 

9. Adjust the columns displayed and the timescale. Move the split bar so that only the Task Name and Duration 

columns are visible, if  needed. Click the Zoom Out button on the Zoom slider in the lower left of  the 
screen to display all of  the symbols in the Gantt chart. Your screen should resemble Figure A-32. 

 

Figure A-32. All task durations and recurring task entered 

10. Save your file and name it. Click File on the Menu bar, and then click Save As. Enter 2016schedule as 
the filename, and then save the file to the desired location on your computer or network. Notice that all 
non-recurring tasks still begin on 8/1/16. This will change when you add task dependencies. Keep this 
file open for the next set of  steps. 
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Establishing Task Dependencies 

To use Project Professional 2016 to adjust schedules automatically and perform critical path analysis, you must 
determine the dependencies or relationships among tasks. There are several different methods for creating 
task dependencies: using the Link Tasks button, using the Predecessors column of the Entry table or the 
Predecessors tab in the Task Information dialog box, or clicking and dragging the Gantt chart symbols for 
tasks with dependencies. You will use the first two methods in the following steps. 

To create dependencies using the Link Tasks button, highlight tasks that are related and then click 
the Link Tasks button under the Task tab, Schedule group. For example, to create a finish-to-start (FS) 
dependency between Task 1 and Task 2, click any cell in row 1, drag down to row 2, and then click the Link 
Tasks button. The default type of link is finish-to-start. In the following steps, you will also set up some other 
types of dependencies and use the lag option to set up overlaps between dependent tasks. 

TIP: To select adjacent tasks, click and drag the mouse to highlight them. You can also click the first task, 
hold down the Shift key, and then click the last task. To select nonadjacent tasks, hold down the Control 
(Ctrl) key as you click tasks in order of their dependencies. 

When you use the Predecessors column of the Entry table to create dependencies, you must 
manually enter the information. To create dependencies manually, type the task row number of the preceding 
task in the Predecessors column of the Entry table. For example, Task 3 has Task 2 as a predecessor, which 
can be entered in the Predecessors column, meaning that Task 3 cannot start until Task 2 is finished. To see 
the Predecessors column of the Entry table, move the split bar to the right. You can also double-click on the 
task, click the Predecessors tab in the Task Information dialog box, and enter the predecessors there. 

Next, you will enter the predecessors for tasks as indicated. You will create some dependencies by 
manually typing the predecessors in the Predecessors column, some by using the Link Tasks button, and the 
remaining dependencies by using whichever method you prefer. 

To link tasks or establish dependencies: 

1. Display the Predecessors column in the Entry table. Move the split bar to the right to reveal the full 
Predecessors column in the 2016schedule.mpp file you saved in the previous section. Widen the Task 
Name or other columns, if  needed. 

2. Highlight the cell where you want to enter a predecessor, and then type the task number for its predecessor task. 
Click the Predecessors cell for Task 3, Stakeholder register completed, type 2, and press Enter. 
Notice that as you enter task dependencies, the Gantt chart changes to reflect the new schedule. Also 
notice that several cells become highlighted, showing the Visual Change Highlights feature of  Project 2016. 

3. Enter predecessors for Task 4 and view the Task Path. Click the Predecessors cell for Task 4, type 2, 
and press Enter. Click the Format tab, and then click the Task Path button under the Bar Styles 
group. Experiment with the options to highlight Predecessor, Driving Predecessors, Successors, and 
Driven Successors, and then click Remove Highlighting. Click the Tasks tab. 

4. Establish dependencies using the Link Tasks button. To link Tasks 5 and 6, click the task name for 
Task 5 in the Task Name column and drag down through Task 6. Then, in the Task tab, click the 
Link Tasks button (looks like a chain link) under the Schedule group. Notice that the result is the 
same as typing 5 in the Predecessors column for Task 6, as shown in Figure A-33. 

  



                                               Schwalbe Publishing, Copyright 2018 30 

 

   Link Tasks icon                Predecessors            Changes in Gantt chart 

 

Figure A-33. Entering predecessors 

5. Enter dependencies and lag time using the Task Information dialog box. Double-click on the Task Name for Task 
5, Project charter, and then click on the Predecessors tab in the Task Information dialog box. Click in the cell under 
Task Name, and then click the Task Name down arrow and select Stakeholder identification. Click the Type 
drop down arrow to see the various types of  dependencies. For this task, you will keep the default type of  finish-to-start. 
Click the cell under the Lag column, then type -50% and press Enter. (Lag means there is a gap between tasks, 
and lead or negative lag means there is an overlap). Your screen should resemble Figure A-34. Click OK to close the dialog 
box. Notice that the Predecessor column for task 5 displays 2FS-50%, meaning there is a finish-to-start relationship with 
task 2 and a lag of  -50%, meaning the task can start when task 2 is 50% completed. 

 

Figure A-34. Entering predecessor information using the task information dialog box 

6. Enter remaining dependencies. Link the other tasks by either manually entering the predecessors into 
the Predecessors column, by using the Link Tasks button, or using the Task Information dialog box. Use 
the information in Figure A-35 to make your entries, being careful to leave some of  the predecessors 
blank, as shown. If  you have entered all data correctly, the project should end on 11/11, or November 
11, 2016.  
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Task Row Task Name Predecessors 

3 Stakeholder register completed 2 

4 Stakeholder management strategy completed 2 

5 Project charter 2FS-50% 

6 Project charter completed 5 

7 Kickoff  meeting 2,6 

8 Kickoff  meeting completed 6,7 

9 Planning  

10 Schedule 5,12FS-50% 

11 Gantt chart completed 10 

12 Scope statement 5 

13 Initial scope statement completed 12 

14 Executing  

15 Deliverable 1  

16 Activity D1 12 

17 Activity D2 12 

18 Deliverable 1 completed 16, 17 

19 Deliverable 2  18 

20 Deliverable 3 18 

21 Monitoring and Controlling  

22 Actual hours tracking 2 

23 Project documents updates 3 

24-39 Progress Report 1 through Closing  

40 Final project report 20 

41 Final presentation 20 

42 Project completed 40, 41 

Figure A-35. Predecessor information 



                                               Schwalbe Publishing, Copyright 2018 32 

 

7. Adjust several dates. You know that you have to deliver the two progress reports on specific dates. Click 

on the Start dates for Tasks 24 and 25 and change those dates to September 2 and October 7. Also 
change the Finish dates for tasks 22 and 23 to November 10 to be more realistic. Project 2016 will 
display a yellow warning symbol to remind you that you are changing default dates, which is fine in these 
examples. 

8. Review the file. If  needed, click the Zoom Out button on the Zoom slider to adjust the timescale so all 

of  the information shows on your screen. Collapse the recurring tasks for the Team review meetings. 
When you finish, your screen should resemble Figure A-36. Double-check your screen to make sure you 
entered the dependencies correctly. 

 

Figure A-36. File with durations and dependencies entered 

9. Preview and save your file. Click the File tab, and then select Print to preview and print your file. 
Click Page Setup, and then click the option to Fit to 1 so it will print on one page, as shown in 
Figure A-37.  Be careful before printing any Project 2016 files so you do not waste a lot of  paper. When 
you are finished, click Save to save your file again. Keep the file open for the next set of  steps. 
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Figure A-37. File set up to print on one page 

Gantt Charts, Network Diagrams, and Critical Path Analysis 

Project Professional 2016 shows a Gantt chart as the default view to the right of the Entry table. As described 
earlier in this text, network diagrams are often used to show task dependencies. This section explains 
important information about Gantt charts and network diagrams and describes how to make critical path 
information more visible in the Gantt Chart view. 

Because you have already created task dependencies, you can now find the critical path. You can view 
the critical tasks by changing the color of those items in the Gantt Chart view. Tasks on the critical path will 
automatically be red in the Network Diagram view. You can also view critical path information in the 
Schedule table or by using the Critical Tasks report. 

To make the text for the critical path tasks appear in red on the Gantt chart: 

1. Change the critical tasks format. Using the 2016schedule.mpp file you previously saved, click the Format tab, 
and then click the Critical Tasks check box in the Bar Styles group, as shown in Figure A-38. 
Notice that the critical tasks display in red in the Gantt chart. You can also quickly change the Gantt 
Chart Style by clicking one of  those options. 
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  Critical Tasks check box  Gantt Chart Styles 

 

Figure A-38. Formatting critical tasks 

2. View the network diagram. Click the View tab, and then click the Network Diagram button under 
the Task Views group. Click the Zoom Out button on the Zoom slider several times and watch the 
view change. Figure A-39 shows all of  the tasks in the network diagram. Note that milestone tasks, 
such as Stakeholder management strategy completed, the fourth box on the top, appear as pointed 
rectangular boxes, while other tasks appear as rectangles. Move your mouse over that box to see it in 
a larger view. Notice that tasks on the critical path automatically appear in red. A dashed line on a 
network diagram represents a page break. You often need to change some of  the default settings for 
the Network Diagram view before printing it. As you can see, network diagrams can be messy, so you 
might prefer to highlight critical tasks on the Gantt chart as you did earlier for easier viewing. 

 

Figure A-39. Network diagram view 

3.  View the schedule table.  Click the Gantt Chart button under the View tab to return to Gantt 
Chart view. Right-click the Select All button to the left of  the Task Mode column heading and select 
Schedule. Alternatively, you can click the View tab and click the Tables button under the Data 
group and then select Schedule. The Schedule table replaces the Entry table to the left of  the Gantt 
Chart. Your screen should resemble Figure A-40. This view shows the start and finish (meaning the 
early start and early finish) and late start and late finish dates for each task, as well as free and total 
slack. Right-click the Select All button and select Entry to return to the Entry table view. 
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Select All button  Schedule table 

 

Figure A-40. Schedule table view 

4. Open the Project Overview report. Click the Report tab, and click the Dashboards button under the 
View Reports group, and then click Project Overview to open the Overview Reports, as shown 
in Figure A-41. Note that the report shows the milestones due and % complete. Examine other 
reports, as desired. 

5. Close the report and save your file. When you are finished examining the reports, return to the Gantt 
chart view, and then click the Save button on the Quick Access toolbar to save your final 
2016schedule.mpp file, showing the Entry table and Gantt chart view. Close Project 2016 if  you are 
not continuing to the next section. 

 

 

Figure A-41. Project Overview report 
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HELP: If you want to download the file 2016schedule.mpp to check your work or continue to the next 
section, a copy is available on the companion Website for this text at www.intropm.com. 

Next you will explore some of the cost and resource management features of Project Professional 
2016. 

PROJECT COST AND RESOURCE MANAGEMENT 

Many people do not use Project Professional 2016 for cost or resource management. Some organizations 
have more established cost management software products and procedures in place, and many people simply 
do not know how to use the cost or resource management features. However, these features make it possible 
to integrate total project information more easily. This section offers brief instructions for entering fixed and 
variable cost estimates, assigning resources to tasks, viewing resource histograms, and entering actual cost and 
schedule information after establishing a baseline plan. It also explains how to use Project Professional 2016 
for earned value management. More details on these features are available in Project Help, online tutorials, or 
other texts. See other chapters of this text for information on some of these concepts. 

Entering Fixed and Variable Cost Estimates 

You can enter costs as fixed or variable. Fixed costs include costs like a specific quantity of materials or costs 
for consultants hired at a fixed cost. Variable costs vary based on the amount of materials or hours people 
work.  On many projects, human resource costs are the largest percentage of total project costs.  

Entering Fixed Costs in the Cost Table 

The Cost table allows you to easily enter fixed costs related to each task. You will enter a fixed cost of $200 
related to Task 15, Deliverable 1. 

To enter a fixed cost: 

1. Display the Cost Table view. Open the file 2016schedule.mpp, if  necessary. Right-click the Select All 
button to the left of  the Task Mode column heading and select Cost. The Cost table replaces the 
Entry table to the left of  the Gantt chart. Widen the Task Name column and then move the Split 
bar to the right, as needed, until you see the entire Cost table. 

2. Enter a fixed cost. In the Fixed Cost column for Task 16, Activity D1, type 200, and press Enter. 

Notice that the Total Cost and Remaining Cost columns reflect this entry, and changes are made to 
several summary tasks and the entire project as well. Your screen should resemble Figure A-42. 
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Select All button    Fixed Cost column of  cost table 

 

 

Figure A-42. Entering a fixed cost 

Entering Resource Information and Cost Estimates 

Several methods are available for entering resource information in Project Professional 2016. The Resource 
Sheet allows you to enter the resource name, initials, resource group, maximum units, standard rate, overtime 
rate, cost/use, accrual method, base calendar, and code. Once you have established resources in the Resource 
Sheet, you can assign those resources to tasks in the Entry table with the list arrow that appears when you 
click a cell in the Resource Names column. The Resource Names column is the last column of the Entry 
table. You can also use other methods for assigning resources, such as using the Assign Resources button or 
using the split window, which is the recommended approach to have the most control over how resources are 
assigned because Project Professional 2016 makes several assumptions about resources assignments that 
might mess up your schedule or costs. Next, you will enter information for three people and assign them to a 
few tasks using various methods. 

To enter basic information about each person into the Resource Sheet and assign them to tasks using 
the Entry table and toolbar: 

1. Display the Resource Sheet view. Click the View tab, and then click the Resource Sheet button 
under the Resource Views group. 

2. Enter resource information. Enter the information from Figure A-44 into the Resource Sheet. The 
three resources names are Kathy, Dan, and Scott. The Std. Rate and Ovt. Rate for Kathy is 40, and 
the Std. and Ovt. Rates for Dan and Scott are 30. Type the information as shown and press the Tab 
key to move to the next field. When you type the standard and overtime rates, you can just type the 
number, such as 40, and Project Professional 2016 will automatically enter $40.00/hr. The standard 
and overtime rates entered are based on hourly rates. You can also enter annual salaries by typing the 
annual salary number followed by /y for “per year.” Your screen should resemble Figure A-43 when 
you are finished entering the resource data. 
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Figure A-43. Resource sheet view with resource data entered 

TIP: If you know that some people will be available for a project only part time, enter their percentage of 
availability in the Max Units column of the Resource Sheet. Project Professional 2016 will then automatically 
assign those people based on their maximum units. For example, if someone can work only 50% of his or her 
time on a project throughout most of the project, enter 50% in the Max Units column for that person. When 
you enter that person as a resource for a task, his or her default number of hours will be 50% of a standard 
eight-hour workday, or four hours per day. You can also enter the number of hours each person is scheduled 
to work, as shown later. 

3. Assign resources to tasks. From the View tab, select the Gantt Chart button under the Task Views 
group, and then click the Select All button and switch back to the Entry table. Move the Split bar to 
reveal the Resource Names column, if needed. 

4.  Assign Kathy to task 2, Stakeholder identification. Click in the Resource Names cell for row 2. Click 
the list arrow, click on the checkbox by Kathy, and then press Enter or click on another cell. Notice 
that the resource choices are the names you just entered in the Resource Sheet. Also notice that after 
you select a resource by checking the appropriate checkbox, his or her name appears on the Gantt 
chart, as shown in Figure A-44. To assign more than one resource to a task using the list arrow, 
simply select another checkbox. Note that Project Professional 2016 will assume that each resource is 
assigned full-time to tasks using this method since the task is in automatically schedule mode. Also 
note that you can use filter by Resource Names to only show tasks assigned to specific resources 
after you enter the resources. 

        Filter Resource Names 

 

Figure A-44. Resource assigned using the entry table 

5.  Assign two resources to a task. Click in the Resource Names cell for row 5 (Project charter). Click 
the list arrow, then click on the checkbox by Dan and Kathy, and then press Enter. Notice that 
both resource names appear in the Resource Names column and on the Gantt chart for this task, and 
the task duration remains at 1 week.  

6. Change the resource assignments. Click in the Resource Names cell for Task 2, Stakeholder 
identification, click the list arrow, and add Dan as another resource. Notice that when you change 
an original resource assignment, Project prompts you for how you want to handle the change, as 
shown in Figure A-45. Click the Exclamation point symbol to read your options. In past versions 
of  Project Professional, resource additions would change schedules automatically unless the user 
entered them a certain way. Now you have much more control of  what happens to your schedule and 
costs. In this case, we do want to accept the default of  keeping the duration constant. 
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Figure A-45. Options when additional resources are added to tasks 

7. Review the cost table. Right-click the Select All button to the left of  the Indicators column heading 
and select Cost. Notice that costs have been added to the tasks where you added resources. Project 
assumes that people are assigned full-time to tasks. It is showing a cost of  $2,800 each for Task 2 and 
Task 5. In the next section, you will see how to control resources entries even more. First, right-click 
the Select All button and select Entry to return to the Entry table. 

To control resource and work assignments using the Resource details window: 

1. Open the Resource Form. Notice the red symbols in the Indicator columns for rows/tasks 2 and 
5. Move your mouse over the symbol to read the message about resources being overallocated. Click 
the Task Name for row 2, Stakeholder identification, click the Resource tab, and then click on the 
Details button under the Properties group. A Resource Form is displayed at the bottom of  the 
screen, as shown in Figure A-46. Project Professional 2016 assumes every task is assigned full-time, 
so since Kathy is scheduled on two tasks on the same day, it says she is overallocated.  

TIP:  You can right-click on the lower screen to see additional forms/views. You can click the 

Select All button at the top right of the screen to view different tables at the top of the screen. You 
want to make sure that resource and work hour assignments do not adjust your schedules in ways 
you did not intend. 

2. Make tasks 2 and 5 manually scheduled. Click the drop-down in the Task Mode column for Tasks 2 
and 5 to make them manually scheduled. When you assigned resources, Project Professional 2016 
assumed they were working full-time or 40 hours per week on each task. Because these two tasks 
have days that overlap, there is an overallocation. You do not expect each resource to work that many 
hours, so you can change them by using the Resource Form. 

3.  Change the number of  Work hours. Select Task 2, Stakeholder identification in the top window, 
and then click the Work column in the Resource Form window for Kathy in the lower part of  your 
screen. Type 10h, press Enter, and again type 10h and press Enter for the next task, Task 5, Project 
charter, and then click the OK button. Click Next to see Dan’s Resource Form.  
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Task mode indicator Change # work hours         

 

Figure A-46. Changing Work hours for tasks 

4. Enter additional work hours and review the Gantt chart. Change Dan’s work hours to 10h for Tasks 2 
and 5 as well. Notice in the Gantt chart that the duration for Tasks 2 and 5 are still one week. The 
overallocation indicator should now disappear because the number of  hours has been reduced from 
the default of  8 hours per day, or 40 hours for a 5-day task. To remove the Resource Form, click 
Details on the Ribbon under the Resource tab. 

5. Examine the new cost information. Click the Select All button, and then click Cost to view the 
Cost table. Tasks 2 and 5 each show only $700 for Total Cost. 

6. Close the file without saving it. Close the file, but do not save the changes you made. 

Using the Team Planner Feature 

Another way to assign resources and reduce overallocations is by using the Team Planner feature. Assume 
you have two people assigned to work on a project, Brian and Cindy, as shown in Figure A-47. Notice that 
Brian is assigned to work on both Task 1 and Task 2 full-time the first week. Therefore, Brian is 
overallocated.  Cindy is scheduled to work on Task 3 full-time the second week, and Task 4, also scheduled 
for the second week, is not assigned yet.  
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Overallocation indicator 

 

Figure A-47. Overallocated resource 

 You can click on the Team Planner view under the View tab to see a screen similar to the top section 
of Figure A-48. Notice that Brian has both Tasks 1 and 2 assigned to him at the same time. These tasks and 
Brian’s name display in red to show the overallocation. Cindy is assigned Task 3 the following week, and Task 
4 is unassigned. By simply clicking and dragging Task 4 straight up so it is under Brian in Week 2 and Task 2 
straight down so it is under Cindy in Week 1, you can reassign those tasks and remove Brian’s overallocation, 
as shown in the bottom section of Figure A-48. Many people will appreciate the simplicity of this feature, first 
introduced in Project 2010! 

Before moving tasks in the Team Planner View: 

 
 
After moving tasks in the Team Planner View: 

 

Figure A-48. Adjusting resource assignments using the Team Planner feature 
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Using the New Resource Engagement Feature 

If you are using Project Professional 2016 with Project Online, then you can take advantage of the new 
resource engagement feature. Figure A-49 shows the Help screen explaining how it works. 

 

Figure A-49. Using the resource engagement feature 

 

Entering Baseline Plans, Actual Costs, and Actual Times 

After entering information in the Task Name column, establishing task durations and dependencies, and 
assigning costs and resources, you are ready to establish a baseline plan. By comparing the information in 
your baseline plan to actual progress during the course of the project, you can identify and solve problems. 
After the project ends, you can use the baseline and actual information to plan similar, future projects more 
accurately. To use Project Professional 2016 to help control projects and view earned value information, you 
must establish a baseline plan, enter actual costs, and enter actual durations. In the next series of steps you 
will use a new file called 2016actuals.mpp that you downloaded from the companion Website for this text 
(www.intropm.com). 
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To save a file as a baseline and enter actual information: 

1. Open the file called 2016actuals.mpp. The file should be showing the Cost table view. Notice that this 
short project was planned to start on January 7, 2013 and end on February 13 of the same year, have 
three resources assigned to it, and cost $11,200. Click the Project tab, click the Set Baseline button 
under the Schedule group, and click Set Baseline. Your screen should resemble Figure A-50. 

    Set Baseline 

 

Figure A-50. Saving a baseline 

2. Save the file as a baseline. Examine the Set Baseline dialog box. Click the drop-down arrow to see 
that you can set up to ten baselines. Accept the default to save the entire project. Click OK. Notice 
that the Baseline column changes to have a light blue background color. 

3.  Display the Tracking table. Click the Task tab, right-click the Select All button and then click 
Tracking to view the tracking table. Move your mouse over each tracking button in the Ribbon to 
see what it does. Your screen should resemble Figure A-51. 

     Tracking table        Tracking buttons 

 

Figure A-51. 
Using the tracking table and tracking buttons 

4. Mark Tasks 2 through 4 as 100% complete. Click the Task Name for Task 2, Subtask 1 under 
Main task 1, and drag down through Task 4 to highlight those tasks. Click the 100% Complete 
button on the Ribbon. The columns with dates, durations, and cost information should now 
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contain data instead of  the default values, such as NA or 0%. The % Comp. column should 
display 100%. Adjust column widths if  needed. Your screen should resemble Figure A-52. 
Notice that the Gantt chart bars for those three tasks now have a black line through them. 

Figure A-52. 
Tracking table information 

5. Enter actual completion dates for Task 6. Click the Task Name for Task 6, Subtask 1 under 
Main task 2, click the Mark on Track drop-down, and then click Update Tasks. The Update 
Tasks dialog box opens. For Task 6, enter the Actual Start date as 1/28/13 (the same as the 
Current Start date) and the Actual Finish date as 2/11/13 (ten days later than the Current 
Finish date), as shown in Figure A-53. Click OK. Notice how the information in the tracking 
sheet has changed. 

 

Figure A-53. Update Tasks dialog box 

6. View the Tracking Gantt chart. Click the drop-down arrow on the far left of  the screen where it 
says Gantt chart, and then click Tracking Gantt to quickly switch to that view. Move the split 
bar and adjust column widths as needed. Use the horizontal scroll bar in the Gantt chart 
window to the right (move the slider to the left) to see symbols on the Tracking Gantt chart. Use 
the Zoom slider on the lower right of  the screen to adjust the timescale so you can see all of  the 
symbols. Your screen should resemble Figure A-54. The blue bar for task 6 shows the actual time 
you just entered. Notice that the delay in this one task on the critical path has caused the planned 
completion date for the entire project to slip (now Feb 25 versus Feb 13). Also notice the 
Indicator column to the far left. The check marks show that tasks are completed. 

Completion indicator                             Tracking Gantt chart 

 

Figure A-54. Tracking Gantt chart view 
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7. Save your file as a new file named 2016actuals.mpp. Click File on the Menu bar, and then click Save 
As. Name the file 2016actuals, and then click Save. 

Notice the additional information available on the Tracking Gantt chart. Completed tasks have 100% 
by their symbols on the Tracking Gantt chart. Tasks that have not started yet display 0%. Tasks in progress, 
such as Task 5, show the percentage of the work completed (35% in this example). The project summary task 
bar indicates that the entire project is 57% complete. Viewing the Tracking Gantt chart allows you to easily 
see your schedule progress against the baseline plan. After you have entered some actuals, you can review 
earned value information for the initiating tasks of this project. Of course you should continue this process of 
entering actuals on a real project until it is completed and include the final earned value data in a final project 
report.   

VIEWING EARNED VALUE MANAGEMENT DATA 

Earned value management is an important project management technique for measuring project 
performance. Because you have entered actual information, you can now view earned value information in 
Project Professional 2016. You can also view an earned value report using the visual reports feature.   

 To view earned value information: 

1. View the Earned Value table. Using the 2016actuals file you just saved (or downloaded from the 
companion Website), click the Select All button, select More Tables, and double-click Earned 
Value. Move the split bar to the right to reveal all of  the columns, as shown in Figure A-55. Note 
that the Earned Value table includes columns for each earned value acronym, such as PV, EV, AC, 
SV, CV, etc. Also note that the EAC (Estimate at Completion) is higher than the BAC (Budget at 
Completion) for Task 6, where the task took longer than planned to complete. Task 0 shows a VAC 
(Variance at Completion) of  ($3,360.00), meaning the project is projected to cost $3,360 more than 
planned at completion. Remember that not all of  the actual information has been entered yet. Also 
note that the date on your computer must be set later than the date of  a completed task for the data 
to calculate properly. 

Select All button 

 

Figure A-55. Earned value table 

2. View the earned value chart. Click the Report tab, and then click Costs under the View Reports 
group, and then click Earned Value Report, as shown in Figure A-56. You can experiment with 
different report options or click the link to Learn more about earned value, as desired. 
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Figure A-56. Earned value report 

3. Close without saving the file. Click the File tab, click Close, and select No when prompted to save 
the file. You can also exit Project Professional 2016 and take a break, if  desired. 

Next you will use a few more features to help tie your project to other applications. 

INTEGRATING PROJECT PROFESSIONAL 2016 WITH 
OTHER APPLICATIONS AND APPS FOR OFFICE 

Project Professional 2016 provides several features to make it easy to integrate with other applications. For 
example, you can copy data between Project Professional 2016 and other applications (including the timeline), 
or you might want to create hyperlinks to project documents created in Word, Excel, PowerPoint, or other 
applications from within your project files. You can also purchase and add new apps to Project 2016 from 
Microsoft’s Office Store. 

Copying Information between Applications 

Most people are familiar with copying information between Office applications. For example, you can 
highlight a column of data in Excel, select copy, and then select Paste in Project Professional 2016 or other 
applications. You can also create a new Project Professional 2016 file from an existing Excel file by select 
New from Excel Workbook. It is also easy to copy a timeline into another application. 
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To copy a timeline: 

1.  Open another Project Professional 2016 template file. Start Project Professional 2016, and open a 
template file, such as Residential Construction, as shown in Figure A-57.  Notice the timeline near 
the top of  the screen. 

 

Figure A-57. Residential construction template 

2.  Copy the Timeline. Click anywhere on the Timeline, and then click the Copy Timeline button in 
the Copy group on the Ribbon, as shown in Figure A-57, and select For Presentation. 

3.  Paste the Timeline into PowerPoint. Open PowerPoint, change the slide layout to Title and Contents, 
type “Project Timeline” as the title for the slide, and change the theme, as desired (Main Event is 
selected here), and then right-click in the contents section and select Paste picture. Your screen 
should resemble Figure A-58, showing the Project Professional 2016 Timeline in your presentation. 
You can also paste the timeline into other presentation software, as desired. 

4. Close the file without saving it. Click the File tab, click Close, and select No when prompted to save 
the file. 

            Copy Timeline 

 

Figure A-58. Copy Timeline 
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Figure A-59. Timeline picture pasted into PowerPoint 

Creating Hyperlinks to Other Files 

Some people like to use their Project Professional 2016 file as a main source of information for many 
different project documents. To do this, you can simply insert a hyperlink to other document files. For 
example, you can create a hyperlink to the file with the stakeholder register you listed as a milestone in your 
Task Name column earlier. 

 To insert a hyperlink within a file: 

1.  Open the 2016schedule.mpp file. Use the file you saved earlier or download it from the 
companion Website for this text. The Entry table and Gantt Chart view should display. 

2.  Select the task in which you want to insert a hyperlink. Click the Task Name for Task 3, Stakeholder 
register completed. 

3.  Open the Insert Hyperlink dialog box. Right-click in that cell, then click Hyperlink. The Insert 
Hyperlink dialog box opens, as shown in Figure A-60. You will have different folders visible based on 
your computer’s directory structure. 
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Figure A-60. Insert hyperlink dialog box 

4. Double-click the filename of  the hyperlink file. Change the Look in: information until you find where 
you have saved the files you downloaded for this appendix. Double-click the Word file named 
stakeholder register, and then click OK. A Hyperlink button appears in the Indicators column to 
the left of  the Task Name for Task 3. (Note: If  that column does not display, click the Format tab, 
Insert Column, and select Indicators). Move your mouse over the hyperlink button until the mouse 
pointer changes to the Hand symbol to reveal the name of  the hyperlinked file. If  you click on it, the 
file will open. 

Using Project Professional 2016 Apps 

Microsoft has an Office Store where you can download special apps for Project Professional 2016. New apps 
are added often. 

 To explore Project Professional 2016 apps: 

1.  Access the Office Store. With Project Professional 2016 open, click the Project tab, then click Store 
button on the left of  the Ribbon under the Add-ins group. The Office Add-ins dialog box opens, as 
shown in Figure A-61. 
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Figure A-61. Apps for Office dialog box (as of April 2016) 

2.  Explore the Add-ins. Read information about various apps, as desired. 

3. Close Project Professional 2016. Click the Close icon in the upper right of  the window to close the 
application. Select No when prompted to save the file. 

Synching with Project Server and Project Online 

Recall from Figure A-1 that Project Professional 2016 is one of six different versions of Project 2016. One of 
its features is that it can be synched with Project Server and Project Online to allow collaboration with team 
members, PMO staff, and senior executives. Remember that individual projects are often part of programs 
and portfolios created to support organizational strategy.  

 You have really just touched the surface of Project Professional 2016’s powerful features, but you 
probably know more than most people who have this software! Consult other books, online resources, and 
experts for more detailed information to learn even more about Project Professional 2016 and other versions 
of Project 2016.  
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DISCUSSION QUESTIONS 

1. What are the six different versions of  project management software offered by Microsoft? Briefly 
describe how they differ and who uses them. 

2. What are some unique features of  project management software in general? 

3. What are the new features of  Project Professional 2016? 

4. How do you create a WBS in Project 2016? 

5. How do you enter task durations and establish dependencies between tasks? 

6. How do you establish a baseline in Project 2016 and enter actual information? 

7. What type of  information do you see in the Earned Value table? 

8. What are some of  the reports built-in to Project 2016? Which ones do you think are commonly 
used? 

9. How can you access other application files from within Project 2016?  

 

EXERCISES 
1. To make sure you understand the information in this appendix, perform the steps yourself. Print out 

the following screen shots or send them to your instructor, as directed. Remember that you can 
download required files from www.intropm.com. 

a. Figure A-11. Network diagram view 
b. Figure A-16. Resource Overview report 
c. Figure A-23. Adding automatic outline numbers and a project summary task 
d. Create a new Project Professional 2016 file called general-wbs. Make the main categories 

survey phase, design phase, and implementation phase. Include at least two deliverables with 
at least two activities and one milestone under each of the phases. Use meaningful, fictitious 
names for them. For example, you might have a deliverable under survey phase called survey 
with activities called create survey and administer survey and a deliverable called survey 
completed. Enter 0 for the duration of the milestones, but do not enter any durations for the 
other tasks. Be sure to indent tasks and show the outline numbers before printing or 
submitting the file.  
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2. Continue performing the steps in this appendix, starting with the section called Developing the 
Schedule.  Print out the following screens or send them to your instructor, as directed:  

a. Figure A-32. All task durations and recurring task entered 
b. Figure A-39. Network diagram view 
c. Figure A-46. Changing Work hours for tasks 
d. Figure A-56. Earned value report 
e. Continue performing the steps, or at least read them.  Write a one-to-two page paper 

describing the capabilities of Project Professional 2016 and your opinion of this software. 
What do you like and dislike about it? 

3. If you are doing a team project as part of your class or for a project at work, use Project Professional 
2016 to create a detailed file describing the work you plan to do for the project. 

a. Create a detailed WBS, including several deliverables, activities, and milestones. Also 
estimate task durations, link tasks, add tasks to the timeline, and enter resources and costs, 
assign resources, and so on. Save your file as a baseline and print it out or send it to your 
instructor, as directed.  

b. Track your progress on your team project by entering actual cost and schedule information. 
Create a new baseline file if there have been a lot of changes. View earned value information 
when you are halfway through the project or course. Continue tracking your progress until 
the project or course is finished. Print or submit your Gantt chart, Project Summary report, 
Earned Value table, and relevant information to your instructor. 

c. Write a two- to three-page report describing your experience. What did you learn about 
Project Professional 2016 from this exercise? How do you think the software helps in 
managing a project? You may also want to interview people who use project management 
software for their experiences and suggestions. 

END NOTES 
1Marketsandmarkets.com, “Project Portfolio Management (PPM) Market by Platform Type (Software and 
Services), Deployment Type (On-Premises and Cloud), End User, Business Solutions, Industry Vertical, and 
Region - Global Forecast and Analysis to 2020,” February 2016). Note: USD means U.S. dollars. 

 


